Sage 300 Construction and Real Estate

Document Designer

Tutorial and Reference Guide

Certified course curriculum
IMPORTANT NOTICE

This is a publication of Sage Software, Inc.

Copyright © 2015 Sage Software, Inc. All rights reserved.

Sage, the Sage logos, and the Sage product and service names mentioned herein are registered trademarks or trademarks of Sage Software, Inc. or its affiliated entities. Microsoft, Office, and Word are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. This workbook is an independent publication and is not affiliated with, nor has it been authorized, sponsored, or otherwise approved by Microsoft Corporation. All other trademarks are the property of their respective owners.

Your use of this document and the Sage product(s) described herein is governed by the terms and conditions of the Sage End User License Agreement ("EULA") or other agreement that is provided with or included in the Sage product. Nothing in this document supplements, modifies or amends those terms and conditions. Except as expressly stated in those terms and conditions, the information in this document is provided by Sage "AS IS" and Sage disclaims all express, implied or statutory warranties of any kind, including but not limited to the warranties of merchantability, fitness for a particular purpose or of non-infringement. No implied license is granted to you under any Sage intellectual property or trade secret right. Sage reserves the right to revise, supplement or remove information in this document at any time without notice to you or others.

10/2015
Contents

Document Designer ................................................................. 3
   Document Designer Requirements ........................................ 4
   Sage 300 Construction and Real Estate Security ......................... 4
   Templates ........................................................................ 4
   Create a Document ............................................................... 6
   Activity 1—Create a New Document ......................................... 6
   Create a Template .................................................................. 9
   Activity 2—Create a New Template .......................................... 9
   Display Information in a Table ................................................ 12
   Insert Fields From Other Database Tables ................................. 13
   Activity 3—Insert Fields From Other Database Tables ................. 14
   Insert a Table of Information .................................................. 17
   Activity 4—Insert a Table of Information .................................. 17
   Working With Templates ........................................................ 20
   Use an Existing Document as a Template ................................... 20
   Delete a Template .................................................................. 20
   Where Template Files Are Stored ........................................... 21
   Documents Based on Sample Templates .................................... 22
Document Designer

You can now take advantage of today’s industry-standard word processing program, Microsoft Word, with your Sage software. Using Document Designer, you can generate a Word document with your data directly from Sage 300 Construction and Real Estate, then use the powerful word processing features of Word to format and refine your document.

NOTE: Document Designer is available in the U.S., Canadian, and Australian editions of Sage 300 Construction and Real Estate.

In this handout, you will be introduced to Document Designer concepts, including:

- Software requirements.
- How to access and use this feature.
- Creating documents based on templates.
- Designing custom templates.
Document Designer Requirements

In order to use Document Designer, you must have the following installed on your machine:

- Sage 300 Construction and Real Estate CD version 15.1 and higher.
- Microsoft Word 2010 and higher (32-bit).

Sage 300 Construction and Real Estate Security

Document Designer is only available in the Enter Commitment window. To use it, you must have security permissions to:

- JC: Tasks > Commitments or PJ: Contract Control > Commitments.
- Manage Templates and/or Create Documents for Document Designer.

Menu Path—Sage Desktop > Tools Security Administration > Security Permissions by Type > Tasks

WARNING: Record level and file security does not affect Document Designer. In order to safeguard sensitive company information, you should carefully consider which users to grant the permissions to use Document Designer.

Templates

The documents you generate in Document Designer are based on templates. A template contains text, images, formatting, and placeholders for database fields. When it is used to generate a document, the placeholders are replaced by actual values from your data.

Compare the document in Figure 1 to the template in Figure 2 on the next page.
Figure 1—Document

Timberline Construction  
P.O. Box 728  
Beaverton, OR 97005  
(503) 690-6775

NOTICE TO PROCEED

July 28, 2015

Kingston Plumbing  
3459 SW 18th  
Portland, OR 97216

Project: NV Food Warehouse

Dear Turner, Laura:

This notice is to inform you that Kingston Plumbing is to commence with the work agreed upon in subcontract 01001-01 dated 1/14/2013.

Upon receipt of this notice, you are responsible for performing the work under the terms and conditions of the contract and in accordance with specifications.

Please acknowledge receipt and acceptance of this notice by signing in the space provided below, and returning the document. Please contact us at (503) 690-6775 if you have any questions. We look forward to working with you.

Figure 2—Template

{Company Settings:Company Name}  
{Company Settings:Company Address 1}  
{Company Settings:City}, {Company Settings:State} {Company Settings:Zip Code}  
{Company Settings:Phone Number}

NOTICE TO PROCEED

July 28, 2015

{Vendor Name}  
{Vendor Address 1}  
{Vendor City}, {Vendor State}, {Vendor Zip}

Project: {Job Description}

Dear {Vendor Contact Name}:

This notice is to inform you that {Vendor Name} is to commence with the work agreed upon in subcontract {Commitment:Commitment ID} dated {Commitment:Date}.

Upon receipt of this notice, you are responsible for performing the work under the terms and conditions of the contract and in accordance with specifications.

Please acknowledge receipt and acceptance of this notice by signing in the space provided below, and returning the document. Please contact us at {Company Settings:Phone Number} if you have any questions. We look forward to working with you.
Sage provides the following commitment-related sample templates:

- Letter of Intent.docx
- Notice to Proceed.docx
- Purchase Order.docx
- Subcontract Agreement Checklist.docx
- Subcontract.docx.

FOR MORE INFORMATION: See “Documents Based on Sample Templates” on page 22 for examples of documents based on the sample templates.

You can also create custom templates in Document Designer.

FOR MORE INFORMATION: See “Create a Template” on page 9.

FOR MORE INFORMATION: To find out where the template files are stored, see “Where Template Files Are Stored” on page 21.

Create a Document

NOTE: Only users with the security permissions for Create Documents are allowed to perform this task. See “Sage 300 Construction and Real Estate Security” on page 4.

You create a document for one commitment at a time in the Enter Commitment window.

Activity 1—Create a New Document

1. Select JC: Tasks > Commitments or PJ: Contract Control > Commitments.
2. Select the commitment for which you want to create a document and press Enter on your keyboard. You can only print documents for the commitment that is currently in the Enter Commitment window.

TIP: If it is a new commitment, save it first.

3. Click Document Designer.
Menu Path—JC: Tasks > Commitments or PJ: Contract Control > Commitments

4. When the **Document Designer** window opens, select a template and click **New Document**.

**NOTE:** The **Document Designer** window does not display templates that are already open in Microsoft Word.
5. When the **New Document** window opens:

- Enter the file name for the document (a); the file extension is automatically *docx*.
- By default, the file is saved in your company data folder or the location specified in **File Locations (File > Company Settings)** for **Attachments**. If you want to save the file elsewhere, click the browse button (b) to specify the location.
- If you want to access the document through a file link in the **Commitment Attachments** window in the future, select the **Link as Attachment** check box (c).
- Click **Create New Document**.

6. The document opens in Microsoft Word and contains information about the commitment that is currently in the **Enter Commitment** window. If needed, you can type additional text or apply formatting to finalize the document.

7. When you are finished with the changes, save the document in Microsoft Word.

**TIP:** If you did not make any changes to the document, you do not need to save it before closing Microsoft Word.

**WARNING:** Unlike Sage 300 Construction and Real Estate reports and inquiries which restrict the information that a user can access based on record level and file security, documents created through Document Designer do not. For example, your template includes bank information from the Cash Management master and transaction files. Even though the user does not have security permissions to these files, when he uses the template to create a document, the bank information is included. In order to safeguard sensitive company information, you should carefully consider which users to grant the permissions to use Document Designer. See “Sage 300 Construction and Real Estate Security” on page 4.
Create a Template

When you create a template, you define the text, images, database fields as placeholders, and formatting.

The first time you use Document Designer to open an existing template or create a new template, you will be prompted to install the Word Document add-in in Microsoft Word.

Activity 2—Create a New Template

NOTE: Only users with the security permissions for Manage Templates are allowed to perform this task. See “Sage 300 Construction and Real Estate Security” on page 4.

1. Select JC: Tasks > Commitments or PJ: Contract Control > Commitments.
2. Select a commitment and press Enter on your keyboard.

NOTE: After you create the template, you will be able to use it with any commitment.

3. Click Document Designer.

5. In the New Template window, enter a name for the template. Do not use the same name as a template that already exists in the Document Designer window.

When you click Create New Template, the software automatically creates a Microsoft Word document and saves the file (*.docx) to the User Template folder of where Sage 300 Construction and Real Estate is installed on your server.
FOR MORE INFORMATION: To find out where the template files are stored, see “Where Template Files Are Stored” on page 21.

6. The template opens in Microsoft Word.
   - You enter text, apply formatting, and insert images in the template content area (a).
   - You use the Document Actions pane (b) to insert database fields as placeholders in the template content area.

TIP: If the Document Actions pane is not automatically displayed, go to the View tab and click Document Actions in the toolbar.
7. In the **Document Actions** pane, the fields for a specific database table (a) are displayed in the list (b). In the example shown below, the list shows fields from the Commitment table (**JCM.Commitment**).

![Document Actions pane with fields listed](image)

8. To add a field to the template content area, select it from the **Document Actions** pane and then click **Insert Field** or double-click. You can only select one field at a time.

9. Once a field is added to the template content area, it becomes a placeholder object and is shown with the full database name (table.field) enclosed with curly braces. For example, Commitment appears as **{Commitment.Commitment}**. Notice a border appears around the placeholder object when you select it.

```plaintext
{Commitment.Commitment}
```
As you design your template, make sure you type outside the placeholder object because any text that is entered inside the border is not shown when you generate a document.

<table>
<thead>
<tr>
<th>Incorrect</th>
<th>Correct</th>
</tr>
</thead>
<tbody>
<tr>
<td>You type the comma inside the placeholder object; the comma will not appear when you generate a document from the template</td>
<td>You type the comma outside the placeholder object; the comma will appear when you generate a document from the template.</td>
</tr>
</tbody>
</table>

Incorrect
Subcontractor [Vendor Name], agrees to furnish

Correct
Subcontractor [Vendor Name], agrees to furnish

10. To delete a placeholder field from the template content area, select it and press **Delete** on your keyboard.

11. After you finish designing your template, remember to save it in Microsoft Word.

**TIP:** As you work on your template design, remember to save the file periodically in Microsoft Word.

**Display Information in a Table**

You may want use a table (with or without borders or grid lines) to display or align information in columns.

After you insert the table (MS Word: **Insert (tab) > Table**), be sure to insert text or a space in a table cell before you insert a field in that table cell. Otherwise, when you use the template to generate a document, the field name will appear instead of the actual value from your database.
Insert Fields From Other Database Tables

When you initially open a template, the Document Actions pane only shows fields from the Commitment table (JCM.Commitment). This may not be enough for your document; you may also want to show information about the job, vendor, and so on.

Let’s take the document shown in Figure 3 as an example—in addition to the commitment scope of work (d), you want to show your company name and address (a), the name of the subcontractor/vendor (b), and the job description (c). The information for (a) to (c) comes from other database tables.

Figure 3—Sample document

<table>
<thead>
<tr>
<th>Item</th>
<th>Database Table</th>
<th>Field(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>Company Settings</td>
<td>Company Name, Address 1, City, State, Zip Code</td>
</tr>
<tr>
<td>b</td>
<td>Vendor</td>
<td>Name</td>
</tr>
<tr>
<td>c</td>
<td>Job</td>
<td>Description</td>
</tr>
<tr>
<td>d</td>
<td>Commitment</td>
<td>Scope of Work</td>
</tr>
</tbody>
</table>

The table below shows the database fields used as placeholders in the document.

Follow the steps in Activity 3 to learn how to insert these database fields in a template.
Activity 3—Insert Fields From Other Database Tables

1. If you saved and closed the template from the last activity, select it in the Document Designer window and click Edit Template.

2. When the template initially opens, you only see fields from the Commitment table (JCM.Commitment) in the Document Actions pane. To switch to another database table, click the browse button.

3. The Select Database Table window opens, listing tables that are related to the previous table. In the example shown below: Company Settings, Job (JCM.Job), Vendor (APM.Vendor), and Bank Account (CMM.Bank Account) are included because they are related to Commitment (JCM.Commitment).

WARNING: Users are not affected by file security when creating or editing Document Designer templates, even if this type of security is activated in Sage 300 Construction and Real Estate. In order to safeguard sensitive company information, you should carefully consider which users to grant the permissions to use Document Designer. See “Sage 300 Construction and Real Estate Security” on page 4.

4. Select Company Settings and click OK.
5. Notice the list in the **Document Actions** pane now displays fields from **Company Settings**.

![Document Actions pane with Company Settings]

6. Insert fields from the Company Settings table into the template content area as needed.

7. Next, you use the Vendor table. In the **Document Actions** pane, click the browse button, and then select **JCM.Commitment** and click **OK**.

8. Click the browse button again, and then select **APM.Vendor** and click **OK**.

![Select Database Table dialog with JCM.Commitment and APM.Vendor tables]
9. The list now shows fields from the Vendor table, the last table added. Insert fields from this table into the template content area as needed.

10. Next, you use the Job table. When you click the browse button next to **APM.Vendor**, notice that the Job table is not shown in the **Select Database Table** window. This is because Job is not related to Vendor.

11. Click **Cancel** to close the **Select Database Table** window.

12. Click **JCM.Commitment** to navigate back to the Commitment table. Notice that **APM.Vendor** is removed.

13. Click the browse button. Now, **JCM.Job** is in the **Select Database Table** window and you can select it.

14. Insert fields from the Job table into the template content area as needed.

15. To insert fields from the Commitment table, click **JCM.Commitment** to navigate back to that table.
16. Save and close the template in Microsoft Word.

Insert a Table of Information

You may want to show commitment items in your document. For example, the quantity and price of all the items in a purchase order. To do so, you add the database fields in a table format in the template. This is because of the one-to-many relationship between Commitment and Commitment Items—each commitment can have many commitment items.

TIP: Remember you can always apply formatting in Microsoft Word and change the border style and shading in the table.

Follow the steps in Activity 4 to learn how to include commitment items in a template.

Activity 4—Insert a Table of Information

1. If you saved and closed the template from the last activity, select it in the Document Designer window and click Edit Template.

2. In the Documents Action pane, click JCM.Committent to navigate back to the Commitment table (if there are other database tables shown).

3. Click Insert Table.
4. In the **Select Database Table** window, select **JCM.Commitment Item** and click **Select Fields**.

**NOTE:** When you click **Insert Table**, the **Select Database Table** window displays tables that have a many-to-one relationship with the last table added in the **Document Actions** pane. For example, **JCM.Commitment Item** has a many-to-one relationship with **JCM.Commitment** because there may be several commitment items for each commitment.
5. The Select Fields for Table window opens and you select the fields for the template content area.

Under Available Fields, double-click the following fields to add them as Selected Fields: Item Number, Description, Amount.

The fields will appear as columns in the order displayed. Use the up and down arrows to rearrange the order if needed.

Clear the Include column headings check box if you do not want to show column headings.

Click OK.

6. The commitment items appear in a table format in the template content area.

7. Apply formatting to the table as needed.

8. Save and close the template in Microsoft Word.
Working With Templates

When you work with templates, do not open the file directly in Microsoft Word. Instead, open the Document Designer window from the Enter Commitment window, and then select a template and click Edit Template.

When the template opens in Microsoft Word, it is a version that is integrated with Sage 300 Construction and Real Estate. Make any edits as needed, and then save the file. If you save the file with another name, make sure to save it to the proper location—see “Where Template Files Are Stored” on page 21.

Also, you cannot copy a placeholder database field from one template and paste it into another template. Although it may appear that the field was copied, documents created using that template may not generate data for that placeholder.

Use an Existing Document as a Template

If you have an existing document that you want to use as a template, follow these steps:

1. Create a new template through the Document Designer window. This opens an instance of Word that is integrated with Sage 300 Construction and Real Estate.

2. Within Word, open your existing document and copy the content.

3. Paste the copied content into your new template.

4. Insert database fields as needed into your new template.

5. Save your new template.

Delete a Template

When you select a template in the Document Designer window and click Delete Template, it removes the template from the list and deletes the template file.
Where Template Files Are Stored

- The **Document Designer** window only display templates stored in this location:
  ```plaintext
  \Servername\ProgramData\SAGE\TIMBERLINE\OFFICE\9.5\ACCOUNTING\WordIntegration\UserTemplate
  ```
  All sample templates and the custom ones that you create are saved to the UserTemplate folder by default.

- If you deleted or edited the sample templates and want to restore them to their original state, you can locate the backup files in this location:
  ```plaintext
  \Servername\ProgramData\SAGE\TIMBERLINE\OFFICE\9.5\ACCOUNTING\WordIntegration\Backup\UserTemplate
  ```

- The file named `Sage.LS1.WordDocumentAddinMasterTemplate.docx` is required for the Document Designer feature—do not delete, edit, or move this file. It is stored in this location.
  ```plaintext
  \Servername\ProgramData\SAGE\TIMBERLINE\OFFICE\9.5\ACCOUNTING\WordIntegration\MasterTemplate
  ```
Figures 4 to 8 show examples of documents based on the sample templates provided by your Sage software.

**Figure 4—Letter of Intent**

Timberline Construction  
P.O. Box 728  
Beaverton, OR  97006  
(503) 690-8775

LETTER OF INTENT

January 31, 2013

Timberline Construction  
P.O. Box 728  
Beaverton OR  97006

PROJECT: Tri-Tech Fab Lab

Attention: Parker Stevens:

Congratulations, Marion County Excavation has been selected to perform on the Tri-Tech Fab Lab project. Please consider this document as our “Letter of Intent to Issue a Contract” for your work on this project. No physical labor or order of material is to be performed until a fully executed subcontract is received from your firm.

We will issue a formal Subcontract. When issued, the Subcontract shall replace this Letter of Intent. Upon receipt of an executed Subcontract from your firm we will issue a written “Notice to Proceed” directing your firm to commence work. No other notice shall be valid to authorize your firm to proceed, including but not limited to, verbal authorization from any Timberline Construction employee or agent.

We look forward to working with you on this project. Should you have any questions or need additional information, please feel free to contact our office at (503) 690-8775.

Sincerely,
Figure 5—Notice to Proceed

Timberline Construction
P.O. Box 728
Beaverton, OR 97000
(503) 600-8775

NOTICE TO PROCEED

January 31, 2013

Bronson Signs
267 Ivy Street
Oregon City, OR 97048

Project: NW Food Warehouse

Dear Steve Hall:

This notice is to inform you that Bronson Signs is to commence with the work agreed upon in subcontract 2307 dated 1/20/2013.

Upon receipt of this notice, you are responsible for performing the work under the terms and conditions of the contract and in accordance with specifications.

Please acknowledge receipt and acceptance of this notice by signing in the space provide below, and returning the document. Please contact us at (503) 600-8775 if you have any questions. We look forward to working with you.

Sincerely,

Michael Perkins

I acknowledge receipt of this notice on ___________ [date]
Authorized signature: ________________________________
Print Name: ________________________________
Title: ________________________________
Figure 6—Purchase Order

Timberline Construction  
P.O. Box 728  
Beaverton, OR 97008  
(503) 660-9775

PURCHASE ORDER

To: 
Charlie Davison  
NW Concrete  
510 Wilsonville Hwy  
Wilsonville, OR, 97070

Order #: 2300  
Date: 1/19/2013  
Job: 03-301 NW Food Warehouse

Ship To:  
3423 SW 185th Avenue  
Beaverton, OR, 97006

<table>
<thead>
<tr>
<th>Ordered By</th>
<th>Delivery Date</th>
<th>Ship Via</th>
<th>F.O.B.</th>
<th>Terms</th>
</tr>
</thead>
<tbody>
<tr>
<td>RG</td>
<td>Truck</td>
<td>30</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Job</th>
<th>Extra</th>
<th>Cost Code</th>
<th>Cat</th>
<th>Description</th>
<th>Units</th>
<th>Unit</th>
<th>Unit Cost</th>
<th>Amount</th>
<th>Tax</th>
</tr>
</thead>
<tbody>
<tr>
<td>03-001</td>
<td>1-510</td>
<td>M</td>
<td></td>
<td>Asphalt Concrete Paving</td>
<td>5,563.0000</td>
<td>cuyd</td>
<td>12.9100</td>
<td>72,076.53</td>
<td>0.00</td>
</tr>
<tr>
<td>03-001</td>
<td>1-529</td>
<td>M</td>
<td>5000 psi</td>
<td></td>
<td>60.0000</td>
<td>cuyd</td>
<td>56.0000</td>
<td>3,360.00</td>
<td>0.00</td>
</tr>
<tr>
<td>03-001</td>
<td>3-310</td>
<td>M</td>
<td>3500 psi</td>
<td></td>
<td>1,195.0000</td>
<td>cuyd</td>
<td>55.0000</td>
<td>123,320.00</td>
<td>0.00</td>
</tr>
<tr>
<td>03-001</td>
<td>3-478</td>
<td>M</td>
<td></td>
<td>Tilt-Up 4000 psi</td>
<td>477.5000</td>
<td>cuyd</td>
<td>55.0000</td>
<td>26,740.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

TOTAL: $225,096.53

Signed:

NW Concrete  
Timberline Construction

By  
By  

Print Name  
Print Name  

Print Title  
Print Title
Figure 7—Subcontract Checklist

Timberline Construction
P.O. Box 728
Beaverton, OR 97006

SUBCONTRACT REQUIREMENTS CHECKLIST

January 15, 2013

NW Concrete
515 Wilsonville Hwy
Wilsonville, OR 97070

Project: 03-001 NW Food Warehouse
Subcontract: 2309 Concrete & Paving Material

- Return two (2) executed copies of your subcontract agreement. One fully executed copy will be returned to you.
- Current Worker’s Compensation insurance certificate
- Current Auto insurance certificate
- Current General Liability insurance certificate
- W-9
- Copy of State contractor’s license
- Copy of City business license
- Company contact sheet
- Schedule of values
- Secondary subcontractor and vendor list
- Confidentiality agreement, if applicable

All certificates need to name Timberline Construction as additional insured, and must list the project name and project number.

Additional forms may be required on specific projects. NW Concrete is responsible for making sure that all conditions are met as some requirements may vary. If a project requires a document that is similar to these document requirements, both requirements must be met.

Please contact Michael Perkins at (503) 590-8775 if you have any questions. We look forward to working with you.
Figure 8—Subcontract

Timberline Construction
P.O. Box 728
Beaverton, OR  97006
(503) 890-8775

SUBCONTRACT

To:  Parker Stevens  Subcontract #:  03001-0001
Marion County Excavation
5420 Lancaster Drive
Salem, OR, 97305

Job:  03-010 Tri-Tech Fab Lab
Job Address:  1 NW Science Park, Salem, OR

Date:  1/23/2013

Description:  Excavation

Scope of Work:
Scrape rock baske for new building pad. Cut down road to generate dirt for pad and grade out new rock on road. Level off for pad and grade out rock for pad. Dig for drain pipes and backfill after they are installed.

All work is to be coordinated with jobsite superintendent and completed by March 31, 2013.

<table>
<thead>
<tr>
<th>Item Number</th>
<th>Description</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Grading</td>
<td>5,000.00</td>
</tr>
<tr>
<td>2</td>
<td>Excavate &amp; Backfill</td>
<td>5,200.00</td>
</tr>
<tr>
<td>3</td>
<td>Erosion Control</td>
<td>7,500.00</td>
</tr>
</tbody>
</table>

Total Subcontract Amount: $16,700.00

Inclusions:

<table>
<thead>
<tr>
<th>Item Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10 cu yd gravel</td>
</tr>
<tr>
<td>2</td>
<td>1 ton river rock</td>
</tr>
</tbody>
</table>

Exclusions:

<table>
<thead>
<tr>
<th>Item Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Catch basin</td>
</tr>
</tbody>
</table>

Signed:

Marion County Excavation  Timberline Construction

By:  Date:  By:  Date:

Print Name:  Print Name:  
Print Title:  Print Title:  

Page 1 of 1